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C++ Widget Plugin



Introduction to C++ Widget Plugin
Did you ever want to visualize some data in Dewesoft but just couldn't find the right widget? With the help of C++ Widget
Plugin, you can create your own widgets and integrate them directly into Dewesoft. C++ Widget Plugin uses Dewesoft's DCOM
interface to access its internals but abstracts the interaction away from the programmer.

C++ Widget Plugin allows you to create your very own widget and modify its behaviour to suit the needs of the data you want
to present. The code is compiled into an external library and automatically recognized and loaded by Dewesoft. This is why
your widget can be easily exported and imported for use on other computers.

The examples of C++ Widget plugins we mention in this tutorial are available on Dewesoft's webpage under Support >
Downloads > Developers > C++ Plugin. Note that you have to be logged in to access the C++ Plugin section. 
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How to Install the Dewesoft plugin template?
In order to start using C++ Widget Plugin, you must have Visual Studio IDE installed on your system. Some of the reasons we
have chosen Visual Studio are its functionalities, powerful developer tooling, like IntelliSense code completion and debugging,
fast code editor, easy modification/customization, and many more. 

You can download the DewesoftX Widget plugin template the Dewesoft webpage under Support > Downloads > Developers >
C++ Plugin. Note that you have to be logged in to access the C++ Plugin section. After downloading, just double-click the file
and the VSIX installer will guide you through the installation process.

Once Visual Studio is downloaded and installed you will be able to download the Dewesoft plugin template using the New
project window and selecting the DewesoftX C++ Widget plugin template. 

The new project window is accessed in File tab -> New -> Project.
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Example I: Digital meter
To get a better understanding of how to work with C++ Widget Plugin we will implement a very simple widget similar to a
Digital meter that already exists in Dewesoft. The Digital meter shows the value of the channel at the current timestamp, it
allows one input channel at a time and it shows the name of the channel in the top left corner. 

The Digital meter that we will mimic looks like this:

Our widget will also allow only one channel at a time to be shown and we will only show the value of the channel and not the
name. 
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New C++ Widget plugin
Now we go back to Visual Studio. To create a new C++ Widget Plugin we click the Project button in File tab > New > Project.
We select the DewesoftX Widget plugin template as our template and fill in the name of our project. After clicking the
Ok button a wizard window will appear to guide us through the creation of the plugin.

Since your plugin will be integrated inside Dewesoft, it needs to know Dewesoft's location. We can use our custom location
(specifying the absolute path), or we can use the system variable DEWESOFT_EXE_X86 if we use a 32-bit version of Dewesoft
or DEWESOFT_EXE_X64 if we use 64-bit Dewesoft. We set the variable using System properties window (it can be found
pressing Windows key and searching for Edit the system environment variables), and under advanced tab clicking the
Environment variables.

If you only have the 64-bit (or 32-bit) version of Dewesoft on your computer, you will only be able to create 64-bit (or 32-bit)
plugins.

After clicking the Next button the following window appears which is used to set Plugin information such as plugin name, its
ownership, and version.
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Plugin name - The name that will be seen in Dewesoft.
Description - Short description of your plugin.
Vendor - Company that created the plugin.
Copyright - Owner of the plugin.
Major version - Sets the initial major version. The value should change when a breaking change occurs (it's incompatible
with previous versions).
Minor version - Sets the initial minor version. The value should change when new features and bug fixes are added
without breaking compatibility.
Release version - Sets the initial release version. The value should change if the new changes contain only bugfixes.

All fields are optional except for the Plugin name. 

After clicking the Next button a final window appears. This window is used to set your  Base class name . It is used as a prefix
for class and project name. When the Base class name is set, we can click the Finish button and the wizard will generate the
plugin template based on your choices. 
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The Project name is the name of the file created by the Visual Studio.
The Plugin name is is the name of the plugin as seen in Dewesoft.
The Base class name is the name of the plugin inside of Visual Studio and has to be a valid C++ name.

Structure of the solution
When a new C++ Widget plugin project is created, the wizard will create the basic files and project structure needed for
development. In the picture below you can see the structure of a project in a tree view with collapsed items. In our case,
ProTutorial refers to text which was used as the Base class name.

ProTutorialPlugin - The actual plugin implementation
ProTutorialPluginTest - Solution for writing unit tests for ProTutorialPlugin.
gtest - Simple library, required by ProTutorialPluginTest for unit testing your plugin. This project should not be modified. 

As mentioned before, our plugin implementation is inside the ProTutorialPlugin project. It contains files for writing the main
code and the Dewesoft_internal folder with methods for interacting with Dewesoft. The main code of the plugin is written in the
plugin.h and plugin.cpp files. Here we connect the input channels and write the code for behavior of our custom widget. We
can also set additional properties of the plugin and save the setup variables. 
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dewesoft_internal folder should not be modified.
When the solution is built for the Arst time, we recommend rescanning it (to clear cache). If not, some false positive errors
might appear and auto-complete might not work. You can do this by clicking on the Project tab and choosing the Rescan
solution from the drop-down list.
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When our project is successfully generated, we will be able to extend Dewesoft. But before implementing the logic behind our
plugin, let's take a look at how our plugin is integrated into Dewesoft by default. In order to do that, we have to start our
program using the shortcut F5 or pressing the Start button in the center of Visual Studio's main toolbar. 

After Dewesoft loads, our Widget can be accessed in Measure mode under Measure > More > TestWidgetExample. 

As we can see, it already contains an example of widget.
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Example I: Removing sample code
As mentioned before, when we create a new C++ Widget Plugin it already contains an example of a widget. Before we write our
own widget we will remove the code of this example. We will also remove all the methods we won't use for writing our plugin.

It is important to keep in mind that C++ uses header files (you can recognize them by the .h extension) in addition to source
files. Header files are designed to provide information about your class and are used for declaration of variables and methods,
while their initialization is done in the source files with .cpp extension.  In order for our plugin to still work we need to remove
the code from both the .h file and .cpp file.

The plugin.h  file should now look like this:

#pragma once#pragma once
#include "interface/plugin_base.h"#include "interface/plugin_base.h"
#include "dcomlib/dcom_utils/colors.h"#include "dcomlib/dcom_utils/colors.h"

structstruct VisualProperties VisualProperties
{{
}};;

class ProTutorialWidget class ProTutorialWidget :: public Dewesoft public Dewesoft::::WidgetsWidgets::::ApiApi::::WidgetWidget
{{
publicpublic::
        ProTutorialWidgetProTutorialWidget(());;
        ~~ProTutorialWidgetProTutorialWidget(()) override override;;

        staticstatic  voidvoid  getPluginPropertiesgetPluginProperties((PluginPropertiesPluginProperties&& props props));;

        voidvoid  drawCanvasDatadrawCanvasData((DrawDataParamsDrawDataParams&& drawParams drawParams)) override override;;
        voidvoid  acceptInputSlotsacceptInputSlots(()) override override;;

        voidvoid  updateSetupupdateSetup((SetupSetup&& setup setup)) override override;;

        voidvoid  initVisualPropertiesinitVisualProperties((VCPropertiesVCProperties&& visualProperties visualProperties)) override override;;
        voidvoid  updateVisualPropertiesupdateVisualProperties((VCPropertiesVCProperties&& visualProperties visualProperties)) override override;;
        voidvoid  visualPropertyChangedvisualPropertyChanged((stdstd::::stringstring&& groupId groupId,, VCProperty VCProperty&& visualProperty visualProperty)) override override;;
        voidvoid  visualPropertyButtonClickvisualPropertyButtonClick((stdstd::::stringstring&& groupId groupId,, VCProperty VCProperty&& visualProperty visualProperty,,  intint buttonIndex buttonIndex))  
overrideoverride;;
privateprivate::
    VCPropertiesGroup group    VCPropertiesGroup group;;
}};;

and the plugin.cpp file should now look like this:

##includeinclude  "StdAfx.h""StdAfx.h"
##includeinclude  "plugin.h""plugin.h"
##includeinclude  <cstdlib><cstdlib>
##includeinclude  <algorithm><algorithm>
##includeinclude  <assert.h><assert.h>
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namespace dcom namespace dcom == Dewesoft Dewesoft::::UtilsUtils::::DcomDcom::::UtilsUtils;;

ProTutorialWidgetProTutorialWidget::::ProTutorialWidgetProTutorialWidget(())
{{
}}

ProTutorialWidgetProTutorialWidget::::~~ProTutorialWidgetProTutorialWidget(())
{{
}}

voidvoid ProTutorialWidget ProTutorialWidget::::getPluginPropertiesgetPluginProperties((PluginPropertiesPluginProperties&& props props))
{{
 Â  Â props Â  Â props..name name ==  "Pro tutorial""Pro tutorial";;
 Â  Â props Â  Â props..description description ==  "Pro tutorial example example""Pro tutorial example example";;
 Â  Â props Â  Â props..maxAllowedInputChannels maxAllowedInputChannels ==  44;;
 Â  Â props Â  Â props..width width ==  400400;;
 Â  Â props Â  Â props..height height ==  300300;;
 Â  Â props Â  Â props..extendOnAdd extendOnAdd == true true;;
 Â  Â props Â  Â props..hasUnifiedProperties hasUnifiedProperties == true true;;
 Â  Â props Â  Â props..supportsFreezeMode supportsFreezeMode == true true;;
}}

voidvoid ProTutorialWidget ProTutorialWidget::::drawCanvasDatadrawCanvasData((DrawDataParamsDrawDataParams&& drawParams drawParams))
{{
}}

voidvoid ProTutorialWidget ProTutorialWidget::::acceptInputSlotsacceptInputSlots(())
{{
 Â  Â InputSlots inputSlots  Â  Â InputSlots inputSlots ==  getInputSlotsgetInputSlots(());;
 Â  Â InputSlot slot  Â  Â InputSlot slot == inputSlots inputSlots..addSlotaddSlot(());;
 Â  Â slot Â  Â slot..setOnAcceptChannelsetOnAcceptChannel(([[]]((IInputSlotPtr slotIInputSlotPtr slot,, IInputChPtr inputCh IInputChPtr inputCh))  {{
 Â  Â  Â  Â  Â  Â  Â  Â returnreturn true true;;
 Â  Â  Â  Â }}));;

Â  Â  slotÂ  Â  slot..setOnAcceptGroupsetOnAcceptGroup(([[]]((IInputSlotPtr slotIInputSlotPtr slot,, IInputGroupPtr inputGroup IInputGroupPtr inputGroup))  {{
 Â  Â  Â  Â  Â  Â  Â  Â returnreturn true true;;
 Â  Â  Â  Â }}));;
}}

voidvoid ProTutorialWidget ProTutorialWidget::::updateSetupupdateSetup((SetupSetup&& setup setup))
{{
}}

voidvoid ProTutorialWidget ProTutorialWidget::::initVisualPropertiesinitVisualProperties((VCPropertiesVCProperties&& visualProperties visualProperties))
{{
}}

voidvoid ProTutorialWidget ProTutorialWidget::::updateVisualPropertiesupdateVisualProperties((VCPropertiesVCProperties&& visualProperties visualProperties))
{{
}}

voidvoid ProTutorialWidget ProTutorialWidget::::visualPropertyChangedvisualPropertyChanged((stdstd::::stringstring&& groupId groupId,, VCProperty VCProperty&& visualProperty visualProperty))
{{
}}
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voidvoid ProTutorialWidget ProTutorialWidget::::visualPropertyButtonClickvisualPropertyButtonClick((stdstd::::stringstring&& groupId groupId,, VCProperty VCProperty&& visualProperty visualProperty,,  intint  
buttonIndexbuttonIndex))
{{
}}

When we now run the plugin you should get an empty black window when you add the widget to your display.
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Example I: Code
In order for our plugin to work it needs to communicate with Dewesoft. The plugin communicates with Dewesoft through files
and functions found in Dewesoft_internals but we will access this code through functions and variables found in plugin.h and
plugin.cpp files of the project. These files contain functions and events, that are triggered at a certain time (e.g. when
measuring is started, when measuring is stopped, when setup is saved,...). 

In the rest of this section, we describe methods which were modified so our plugin works as it should. 

getPluginProperties
This method gets called when your plugin gets loaded into Dewesoft, this happens every time you start Dewesoft. The
properties set in this method are set only once and cannot be changed later on. We can set the properties for the name and
description of the widget, the default width and height of the window when widget is first added to the display and the number
of channels the widget can display at once. SupportsFreezeMode property enables the widget to also have the data available
in freeze mode. 

voidvoid ProTutorialWidget ProTutorialWidget::::getPluginPropertiesgetPluginProperties((PluginPropertiesPluginProperties&& props props))
{{
    props    props..name name ==  "Pro tutorial""Pro tutorial";;
    props    props..description description ==  "Widget example for Pro tutorial""Widget example for Pro tutorial";;
    props    props..maxAllowedInputChannels maxAllowedInputChannels ==  44;;
    props    props..width width ==  400400;;
    props    props..height height ==  300300;;
    props    props..supportsFreezeMode supportsFreezeMode == true true;;
    props    props..extendOnAdd extendOnAdd == true true;;
    props    props..hasUnifiedProperties hasUnifiedProperties == true true
}}

The last two properties to set affect the behavior of the widget when it is extended to contain multiple controls. These two
properties are connected to the drawing region properties found in the upper part of the left panel that is seen when the widget
is selected. You can add or remove the number of widget by clicking the  or  Controls buttons (see picture below). If
the ..extendOnAddextendOnAdd  property is set to true, then when you add a new widget it is the same size as the first control. But if this
property is set to false then both widgets get scaled to fit in the window of the size set for the first widget. 

These multiple widgets can have unified properties, this means that for example when a user sets the display color for one
widget it gets changed for all of them or if the user changes the graph type from line to histogram then the type of the graph
changes for all widgets. If we do not want to give the user the option to change widget setting uniformly then we set the
..hasUnifiedPropertieshasUnifiedProperties property to false. If this property is set to true the user can still manually disable it by unchecking the
checkbox next to Unified properties (see picture below).
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Widget
The very first procedure that gets called when a new widget is created. We will set the channel precision and font size to the
default values and also check if the default values are correct

ProTutorialWidgetProTutorialWidget::::ProTutorialWidgetProTutorialWidget(())
{{
    userChannelPrecision     userChannelPrecision == kDefaultChannelPrecision kDefaultChannelPrecision;;
    userFontSize     userFontSize == kDefaultFontSize kDefaultFontSize;;

        assertassert((userChannelPrecision userChannelPrecision >=>=  00  &&&&  "Precision can not be smaller than 0.""Precision can not be smaller than 0."));;
        assertassert((userFontSize userFontSize >>  00    &&&&  "Font size must be greater than 0.""Font size must be greater than 0."));;
}}

In order for the above code to work, we also need to define the variables we used in the header file of the plugin. To do that we
will add the following code to the private section ProTutorialWidgetProTutorialWidget  class inside the plugin.h file.

intint kDefaultChannelPrecision  kDefaultChannelPrecision ==  33;;
intint kDefaultFontSize  kDefaultFontSize ==  3636;;

intint userChannelPrecision userChannelPrecision;;
intint userFontSize userFontSize;;

acceptInputSlots
Our widget might not work for all channel types and we want to prevent the user from adding the channel to the widget as this
may produce an error. In our example, we only want to display the scalar channels and not allow the user to choose to display
vector or matrix channels. We also won't allow any channels groups.
In order to do that we use the acceptInputSlotsacceptInputSlots(()) method. An input slot is a placeholder for an individual channel or channel
group that can be assigned. This method gets called every time a channel is added from the widget. Every time an input slot
gets assigned then a new one must be added. This is done with the addSlotaddSlot(()) method. On this new input slot we define which
channel types or group can be added. This is done with a lambda function for setOnAcceptChannelsetOnAcceptChannel(()) and
setOnAcceptGroupsetOnAcceptGroup(()). This function gets called for every channel and group available in the current setup of Dewesoft and if
the return value for some channel or group is true it is then visible on the right panel of the display when the widget is
selected. 
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voidvoid ProTutorialWidget ProTutorialWidget::::acceptInputSlotsacceptInputSlots(())
{{
    InputSlots inputSlots     InputSlots inputSlots ==  getInputSlotsgetInputSlots(());;
    InputSlot slot     InputSlot slot == inputSlots inputSlots..addSlotaddSlot(());;

    slot    slot..setOnAcceptChannelsetOnAcceptChannel(([[]]((IInputSlotPtr slotIInputSlotPtr slot,, IInputChPtr inputCh IInputChPtr inputCh))  {{
                returnreturn  !!inputChinputCh->->ChCh->->ArrayChannelArrayChannel;;
        }}));;

    slot    slot..setOnAcceptGroupsetOnAcceptGroup(([[]]((IInputSlotPtr slotIInputSlotPtr slot,, IInputGroupPtr inputGroup IInputGroupPtr inputGroup))  {{
                returnreturn false false;;
        }}));;
}}

drawCanvasData
Now we are ready to actually visualize the data from our channels. This is done in the drawCanvasDatadrawCanvasData(()) method which
usually gets called with a rate of 50 Hz. This number depends on the refresh rate set in Dewesoft settings or current system
performance. The input parameter of this method is a structure called DrawDataParamsDrawDataParams  that holds the canvas, rect, and
colorPalette. 

It is important that this function runs fast because if it is too slow you can get acquisition data lost.

Before we continue with our example let us take a closer look at these parameters and how to use them.
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The colorPalette parameter holds the information about common colors that all widgets use and are defined by the selected
Dewesoft theme. The following colors are specified:

backColor - the background color of the control
highlightBackColor - the background color of controls that have some sort of user interaction or must be emphasized
fontColor - the color of the font
ticksColor - the color of axis ticks (if drawing graphs)
subticksColor - the color of axis subticks (if drawing graphs)

The rect parameter holds the information of the location and size of the drawing region (rectangle) of the widget. The location
of the rectangle is relative to the display, meaning that the upper left corner of the widget will always have coordinates (0, 0) no
matter where on the display it is located. We will use the rect parameter to calculate the middle of the drawing region to
determine where to display the text. 

intint x  x ==  intint((roundround((rectrect..x x ++  ((rectrect..width width -- rect rect..xx))  //  22  --  ((canvascanvas..getTextWidthgetTextWidth((texttext))  //  22))))));;        
intint y  y ==  intint((roundround((rectrect..y y ++  ((rectrect..height height -- rect rect..yy))  //  22  --  ((canvascanvas..getTextHeightgetTextHeight((texttext))  //  22))))));;

The canvas parameter holds the functions and properties used for drawing. The Font is used for setting the text, the Brush is
used for setting the text and drawn objects (rectangle, circle, etc.) background the Pen is used for setting the borders of drawn
objects (lines, rectangles, etc.) We can set the following properties:

Font:

Color - the color of the font set as a long dcom::Color
Style - the style of the font (bold, italic, underline, strikeout) set as a custom enum, you can combine them by creating a
vector of styles like {cbsBold, cbsUnderline} 
Size - the size of the font set in pixels as an integer
Name - the name of the font family (arial, tahoma, sanserif, etc.) set as a string

Brush:

Color - the color of the brush set as a long dcom::Color
Style - the pattern for the brush (clear, solid, diagonal, vertical, etc.) set as a custom enum

Pen:

Color - the color of the pen set as a long dcom::Color
Style - the style in which the pen draws lines (solid, dot, dash, clear, etc.) set as a custom enum
Width - the width of the pen in pixels set as an integer
Mode - determine how the color of the pen interacts with the color on the canvas (always black, the inverse of canvas
background color, unchanged, etc.)

Majority of the properties are of type integer and to make the code more descriptive we use predefined custom enums to set
them. All enums follow the same naming principle, the prefix of the enum is the first letters of the property you want to set (the
prefix of the enum for setting canvas.getPen().setMode to cpm) followed by the general name of the setting. For example, if
we want to set the font style to bold we would write canvascanvas..getFontgetFont(())..setStylesetStyle(({{cfsBoldcfsBold}})) or if we want to set the pen
style to dashed we would write canvascanvas..getPengetPen(())..setStylesetStyle(({{cpsDashcpsDash}})).
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The properties of the font, brush, and pen have to be set before we start drawing to the canvas as our drawing functions will
use them to draw the objects. To draw on the canvas we use the predefined functions. If we want to just write a text to our
widget we use the textOuttextOut(()) or textRecttextRect(()). The difference between these two functions is that the textRecttextRect(()) function
outputs the text inside a rectangle if the text is too long for the rectangle it gets clipped to fit inside it. We can also draw a
rectangle: use the rectanglerectangle(()) function, an ellipse: use the ellipseellipse(()) function, and a line: use the moveTomoveTo(()) and lineTolineTo(())
functions. The input parameters to all of these functions is the location of the object.
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To get all the input channels the user selected to show on the widget we use the getInputChannelsgetInputChannels(()) method and to get the
current value of the channel we use the getCurrentValuegetCurrentValue(()) method on the channel to read the value from.

In our example, we will just write the current value of the input channel to the canvas. We will use the textOuttextOut(()) function and
we will set the font color to match the color of the channel and the brush style to be clear. The full code in the
drawCanvasDatadrawCanvasData(()) should look like this.

voidvoid ProTutorialWidget ProTutorialWidget::::drawCanvasDatadrawCanvasData((DrawDataParamsDrawDataParams&& drawParams drawParams))
{{
        ifif  ((getInputChannelsgetInputChannels(())..getCountgetCount(())  <<  11))
                returnreturn;;

    Canvas    Canvas&& canvas  canvas == drawParams drawParams..canvascanvas;;
    Rect    Rect&& controlRect  controlRect == drawParams drawParams..rectrect;;
    Channel    Channel&& channel  channel ==  getInputChannelsgetInputChannels(())[[00]];;

        doubledouble currentValue  currentValue == channel channel..getCurrentValuegetCurrentValue(());;
    std    std::::wstring text wstring text ==  ((stdstd::::wstringstreamwstringstream(())  <<<< std std::::setprecisionsetprecision((userChannelPrecisionuserChannelPrecision))  <<<< std std::::fixed fixed <<<< currentValue currentValue

    canvas    canvas..getFontgetFont(())..setSizesetSize((userFontSizeuserFontSize));;

        intint x  x ==  intint((roundround((controlRectcontrolRect..x x ++  ((controlRectcontrolRect..width width -- controlRect controlRect..xx))  //  22  --  ((canvascanvas..getTextWidthgetTextWidth((texttext))  //  
22))))));;
        intint y  y ==  intint((roundround((controlRectcontrolRect..y y ++  ((controlRectcontrolRect..height height -- controlRect controlRect..yy))  //  22  --  ((canvascanvas..getTextHeightgetTextHeight((texttext))  //  
22))))));;

    canvas    canvas..getFontgetFont(())..setColorsetColor((channelchannel..getMainDisplayColorgetMainDisplayColor(())));;
    canvas    canvas..getBrushgetBrush(())..setStylesetStyle((cbsClearcbsClear));;
    canvas    canvas..textOuttextOut((xx,, y y,, text text));;
}}

updateSetup
Even though the user can not change the precision of the channel or the font size of the text just yet (we will do this in the next
section of this tutorial) we still want our plugin to remember and set these values if we save or load the setup with our widget.
Saving or loading a variable is done with the updateupdate(()) function on setup.

The first parameter of the function is the name of XML element under which your setting is saved. This parameter
should be unique for every setting.
The second parameter is the actual value to be stored.
The optional third parameter specifies what the default value should be.

Updating our settings inside plugin.cpp file is done in updateSetupupdateSetup(()) as seen in the code below.
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voidvoid ProTutorialWidget ProTutorialWidget::::updateSetupupdateSetup((SetupSetup&& setup setup))
{{
 Â  Â setup Â  Â setup..updateupdate(("fontSize""fontSize",, userFontSize userFontSize));;
    setup    setup..updateupdate(("channelPrecision""channelPrecision",, userChannelPrecision userChannelPrecision));;
}}
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Example I: Visual Properties
If we now run the plugin by pressing F5 and go to measure tab we can add our widget to the display. On the picture below you
can see how the widget looks like. The channel outputted on the widget is the time signal, you can create it in the Ch. Setup ->
Math -> Formula and under Signals tab choosing time signal.

But what if the user wants a bigger font for the text or wants the output to have more digits. We can add an option to allow the
user to change those settings. We do this by defining the visual properties that can be seen on the left panel when the widget
is selected. We will add a drop-down menu for allowing users to change the font size and a text box for allowing the user to
change the precision of the channel. We will also add a reset button to reset the changed values back to default.

We will define these visual properties as a struct of the type VisualPropertiesVisualProperties  in the plugin.h file

structstruct VisualProperties VisualProperties
{{
        staticstatic constexpr  constexpr charchar FontSizeSelect FontSizeSelect[[]]  ==  "FontSizeSelect""FontSizeSelect";;
        staticstatic constexpr  constexpr charchar ResetButton ResetButton[[]]  ==  "ResetButton""ResetButton";;
        staticstatic constexpr  constexpr charchar PrecisionEdit PrecisionEdit[[]]  ==  "PrecisionEdit""PrecisionEdit";;
}};;

In the background, Dewesoft searches and uses these properties by its names defined as strings.

initVisualProperties
We initialize the visual properties we want to add to our widget in the initVisualPropertiesinitVisualProperties  method. We add them to a group
that we can name. We can create as many groups as we want to visually group the properties and make them easier to use. 

As mentioned before, we will add a drop-down menu, a text box, and a button. All the visual properties are added to the panel
with addadd......PropertyProperty((constconst std std::::stringstring&& propertyId propertyId,,  constconst std std::::wstringwstring&& name name)) functions. The first parameter of the
function is a string name of the property and the second parameter is the text we want to display next to the property.
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We add the drop-down menu with addSelectPropertyaddSelectProperty(()) function. To add the available font sizes to the drop-down we use
the addadd(()) call, we add the sizes as strings. 

To add the text box for precision we call the addFloatPropertyaddFloatProperty(()) function which adds a text box that only allows number
inputs. We also set the minimal and maximal number of decimal points we will allow users to input using the minValue and
maxValue properties of the FloatProperty. If the user inputs invalid precision number the plugin will not take into account the
property change. 

The reset button is added to the panel with addLabelPropertyaddLabelProperty(()) function call. We still need to then add a button to this
property with addButtonaddButton(()) function, the first parameter of the function is a hint and the second is the name of the icon. The
addButtonaddButton(()) function is only available on the label property.

voidvoid ProTutorialWidget ProTutorialWidget::::initVisualPropertiesinitVisualProperties((VCPropertiesVCProperties&& visualProperties visualProperties))
{{
    group     group == visualProperties visualProperties..addOrFindGroupaddOrFindGroup(("Advanced""Advanced"));;
    group    group..setNamesetName((LL"Drawing Options""Drawing Options"));;

    SelectVCProperty     SelectVCProperty fontSizeDropDownfontSizeDropDown((groupgroup..addSelectPropertyaddSelectProperty((VisualPropertiesVisualProperties::::FontSizeSelectFontSizeSelect,, L L"Font"Font  
size"size"))));;
    fontSizeDropDown    fontSizeDropDown..addadd((LL"36""36"));;
    fontSizeDropDown    fontSizeDropDown..addadd((LL"40""40"));;
    fontSizeDropDown    fontSizeDropDown..addadd((LL"44""44"));;
    fontSizeDropDown    fontSizeDropDown..addadd((LL"48""48"));;

    FloatVCProperty     FloatVCProperty precisionEditprecisionEdit((groupgroup..addFloatPropertyaddFloatProperty((VisualPropertiesVisualProperties::::PrecisionEditPrecisionEdit,, L L"Number of"Number of  
decimals"decimals"))));;
    precisionEdit    precisionEdit..setMinValuesetMinValue((00));;
    precisionEdit    precisionEdit..setMaxValuesetMaxValue((1515));;

    LabelVCProperty     LabelVCProperty resetButtonresetButton((groupgroup..addLabelPropertyaddLabelProperty((VisualPropertiesVisualProperties::::ResetButtonResetButton,, L L"Reset to"Reset to  
default"default"))));;
    resetButton    resetButton..addButtonaddButton((LL"Reset properties to default""Reset properties to default",,  "REFRESH""REFRESH"));;
}}

updateVisualProperties
The updateVisualPropertiesupdateVisualProperties(()) procedure gets called immediately after initVisualPropertiesinitVisualProperties(()) and every time after a
visual property changes on visualPropertyChangedvisualPropertyChanged(()). Here we set the values of the properties, but they must be initialized
beforehand. We will set the drop-down menu's chosen item to the value saved in the userFontSizeuserFontSize variable and we will
display the userChannelPrecisionuserChannelPrecision  value in the precision text box.
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voidvoid ProTutorialWidget ProTutorialWidget::::updateVisualPropertiesupdateVisualProperties((VCPropertiesVCProperties&& visualProperties visualProperties))
{{
    group     group == visualProperties visualProperties..findGroupfindGroup(("Advanced""Advanced"));;

    SelectVCProperty     SelectVCProperty fontSizeDropDownfontSizeDropDown((groupgroup..findPropertyfindProperty((VisualProperties::FontSizeSelectVisualProperties::FontSizeSelect))));;
        ifif  ((fontSizeDropDownfontSizeDropDown..isAssignedisAssigned(())))
        {{
                std::wstring fontSizeText = std::to_wstring(userFontSize);std::wstring fontSizeText = std::to_wstring(userFontSize);
Â Â Â Â Â Â Â Â fontSizeDropDown.setItemIndex(0);Â Â Â Â Â Â Â Â fontSizeDropDown.setItemIndex(0);
Â Â Â Â Â Â Â Â for (int i = 0; i < fontSizeDropDown.getCount(); i++)Â Â Â Â Â Â Â Â for (int i = 0; i < fontSizeDropDown.getCount(); i++)
Â Â Â Â Â Â Â Â {Â Â Â Â Â Â Â Â {
Â Â Â Â Â Â Â Â Â Â Â Â if (fontSizeDropDown.getItem(i) == fontSizeText)Â Â Â Â Â Â Â Â Â Â Â Â if (fontSizeDropDown.getItem(i) == fontSizeText)
Â Â Â Â Â Â Â Â Â Â Â Â {Â Â Â Â Â Â Â Â Â Â Â Â {
Â Â Â Â Â Â Â Â Â Â Â Â Â Â Â Â fontSizeDropDown.setItemIndex(i);Â Â Â Â Â Â Â Â Â Â Â Â Â Â Â Â fontSizeDropDown.setItemIndex(i);
Â Â Â Â Â Â Â Â Â Â Â Â Â Â Â Â userFontSize = std::stoi(fontSizeDropDown.getItem(i));Â Â Â Â Â Â Â Â Â Â Â Â Â Â Â Â userFontSize = std::stoi(fontSizeDropDown.getItem(i));
Â Â Â Â Â Â Â Â Â Â Â Â }Â Â Â Â Â Â Â Â Â Â Â Â }
Â Â Â Â Â Â Â Â }Â Â Â Â Â Â Â Â }
        }}

    FloatVCProperty     FloatVCProperty precisionEditprecisionEdit((groupgroup..findPropertyfindProperty((VisualProperties::VisualProperties::PrecisionEditPrecisionEdit))));;
        ifif  ((precisionEditprecisionEdit..isAssignedisAssigned(())))
        precisionEdit        precisionEdit..setValuesetValue((userChannelPrecisionuserChannelPrecision));;
}}

visualPropertyChanged
The procedure which gets called every time a property changes, for example when the user chooses a different font size in the
drop-down menu or when they input a new valid precision. We check which property has changed and assign the changed
property value to the corresponding variable.

voidvoid ProTutorialWidget ProTutorialWidget::::visualPropertyChangedvisualPropertyChanged((stdstd::::stringstring&& groupId groupId,, VCProperty VCProperty&& visualProperty visualProperty))
{{
    std    std::::string propID string propID == visualProperty visualProperty..getIdgetId(());;

        if (propID == VisualProperties::PrecisionEdit)if (propID == VisualProperties::PrecisionEdit)
Â  Â  {Â  Â  {
Â  Â  Â  Â  FloatVCProperty precisionText(visualProperty);Â  Â  Â  Â  FloatVCProperty precisionText(visualProperty);
Â  Â  Â  Â  userChannelPrecision = precisionText.getValue();Â  Â  Â  Â  userChannelPrecision = precisionText.getValue();
Â  Â  }Â  Â  }
Â  Â  else if (propID == VisualProperties::FontSizeSelect)Â  Â  else if (propID == VisualProperties::FontSizeSelect)
Â  Â  {Â  Â  {
Â  Â  Â  Â  SelectVCProperty select(visualProperty);Â  Â  Â  Â  SelectVCProperty select(visualProperty);
Â  Â  Â  Â  userFontSize = std::stoi(select.getItem(select.getItemIndex()));Â  Â  Â  Â  userFontSize = std::stoi(select.getItem(select.getItemIndex()));
Â  Â  }Â  Â  }
}}

visualPropertyButtonClick
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Every time a button on the visual property panel is clicked the visualPropertyButtonClickvisualPropertyButtonClick(()) procedure gets called. In our
case, we will set the font size and precision back to default when the user clicks the reset button.

voidvoid ProTutorialWidget ProTutorialWidget::::visualPropertyButtonClickvisualPropertyButtonClick((stdstd::::stringstring&& groupId groupId,, VCProperty VCProperty&& visualProperty visualProperty,,  intint  
buttonIndexbuttonIndex))
{{
Â  Â  FloatVCProperty precisionText(group.findProperty(VisualProperties::PrecisionEdit));Â  Â  FloatVCProperty precisionText(group.findProperty(VisualProperties::PrecisionEdit));
Â  Â  if (precisionText.isAssigned())Â  Â  if (precisionText.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  precisionText.setValue(kDefaultChannelPrecision);Â  Â  Â  Â  precisionText.setValue(kDefaultChannelPrecision);
 Â  Â  Â  Â userChannelPrecision = kDefaultChannelPrecision; Â  Â  Â  Â userChannelPrecision = kDefaultChannelPrecision;
Â  Â  }Â  Â  }
Â  Â  SelectVCProperty fontSizeDropDown(group.findProperty(VisualProperties::FontSizeSelect));Â  Â  SelectVCProperty fontSizeDropDown(group.findProperty(VisualProperties::FontSizeSelect));
Â  Â  if (fontSizeDropDown.isAssigned())Â  Â  if (fontSizeDropDown.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  fontSizeDropDown.setItemIndex(0);Â  Â  Â  Â  fontSizeDropDown.setItemIndex(0);
Â  Â  Â  Â  userFontSize = kDefaultFontSize;Â  Â  Â  Â  userFontSize = kDefaultFontSize;
Â  Â  }Â  Â  }
}}
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Example I: Result
After all the previous steps our custom widget will look like this:

The input channels our widget accepts are scalar channels and the user can change the font size, precision and then with a
click of the button resets the changes back to default values.
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Example II
In the previous sections of this tutorial, we created a very simple digital meter that accepts scalar channels and displays the
current value of the channel. But let us now move on to a more complicated example. 

We will implement a horizontal bar graph with the value of the channel written at the beginning of the bar and the value visually
represented with the fullness of the bar. This widget will accept multiple channels of scalar, vector or matrix type. We will
allow the user to set the font size of the text displaying the channel name and the minimum and maximum value of the
channel. The user could also choose if they want to use the set minimum and maximum value of the channel. We will also add
a reset button for resetting settings back to default.

In the end, our widget will look like this:
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Example II: Code
To create this widget, we can create an entirely new plugin or change the one we have. In any case, we should again remove all
the code from our plugin and the plugin.h and plugin.cpp files should again look like this. 

getPluginProperties
For this example we will set the plugin properties to allow multiple input channels to be displayed at once, we will allow the
maximum number of input channels to be 4 and we will also make the default window size of the widget a little bit bigger than
in the previous case. 

voidvoid ProTutorialWidget ProTutorialWidget::::getPluginPropertiesgetPluginProperties((PluginPropertiesPluginProperties&& props props))
{{
    props    props..name name ==  "Pro tutorial""Pro tutorial";;        
    props    props..description description ==  "Widget example for Pro tutorial""Widget example for Pro tutorial";;
    props    props..maxAllowedInputChannels maxAllowedInputChannels ==  44;;
    props    props..width width ==  400400;;
    props    props..height height ==  300300;;
    props    props..extendOnAdd extendOnAdd == true true;;
    props    props..hasUnifiedProperties hasUnifiedProperties == true true;;
Â  Â  propsÂ  Â  props..supportsFreezeMode supportsFreezeMode == true true;;
}}
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As mentioned we will allow the user to choose the minimum and maximum value of the channel, this is why we have to add
the variables to hold this values to the private section of the ProTutorialWidgetProTutorialWidget  class in the plugin.h file. At this point we will
also add the variables to hold the information for the font size and whether or not to use the limits for the channel value the
user selected.

intint userFontSize  userFontSize ==  1212;;
bool useManualLimits bool useManualLimits == false false;;
doubledouble minChannelValue  minChannelValue ==  --10.010.0;;
doubledouble maxChannelValue  maxChannelValue ==  10.010.0;;

Widget
In the constructor of the class, we will check if the minimum and maximum channel values we defined are valid.

ProTutorialWidgetProTutorialWidget::::ProTutorialWidgetProTutorialWidget(())
{{
        assertassert((minChannelValue minChannelValue <=<= maxChannelValue  maxChannelValue &&&&  "Minimum channel value cannot be greater than"Minimum channel value cannot be greater than  
maximum channel value."maximum channel value."));;
}}

acceptInputSlots
As mentioned we will create a widget that can display all channel types this is why we will just simply allow all the channels
found in the current setup to be the input channels to our widget.

voidvoid ProTutorialWidget ProTutorialWidget::::acceptInputSlotsacceptInputSlots(())
{{
        InputSlots inputSlots = getInputSlots();InputSlots inputSlots = getInputSlots();
Â  Â  InputSlot slot = inputSlots.addSlot();Â  Â  InputSlot slot = inputSlots.addSlot();

Â  Â  slot.setOnAcceptChannel([](IInputSlotPtr slot, IInputChPtr inputCh) {Â  Â  slot.setOnAcceptChannel([](IInputSlotPtr slot, IInputChPtr inputCh) {
Â  Â  Â  Â  return true;Â  Â  Â  Â  return true;
Â  Â  });Â  Â  });
Â Â 
Â Â Â Â slot.setOnAcceptGroup([](IInputSlotPtr slot, IInputGroupPtr inputGroup) {Â Â Â Â slot.setOnAcceptGroup([](IInputSlotPtr slot, IInputGroupPtr inputGroup) {
Â  Â  Â  Â  return false;Â  Â  Â  Â  return false;
Â  Â  });Â  Â  });
}}

updateSetup
When loading the setup with our widget we want to also load the information of the font size, the minimum and maximum
value of the channel and whether or not to use the limits. In order to do that we need to update the variables that hold this
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information in the updateSetupupdateSetup(()) method.

voidvoid ProTutorialWidget ProTutorialWidget::::updateSetupupdateSetup((SetupSetup&& setup setup))
{{
    setup    setup..updateupdate(("fontSize""fontSize",, userFontSize userFontSize));;
    setup    setup..updateupdate(("minChannelValue""minChannelValue",, minChannelValue minChannelValue));;
    setup    setup..updateupdate(("maxChannelValue""maxChannelValue",, maxChannelValue maxChannelValue));;
    setup    setup..updateupdate(("useManualLimits""useManualLimits",, useManualLimits useManualLimits));;
}}
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The drawCanvasDatadrawCanvasData(()) function will be a little more complicated than in the example before. To make it a little more
understandable we will split the code into multiple smaller functions performing only a specific task. The main
drawCanvasDatadrawCanvasData(())  function and the corresponding helper functions are written and explained in the next section.
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Example II: drawCanvasData
In the code for drawing the widget, we will use a lot of constant values for variables like horizontal and vertical spacing
between two objects, the height of the bar, etc. We will define these values as constants in the private section of the
ProTutorialWidgetProTutorialWidget  class in the plugin.h file, to distinguish them from other variables we will use the prefix "k". The names of
the constants should be descriptive enough for other developers to know what they mean and what they are used for when
they see them.

constconst  intint kBarHeight  kBarHeight ==  1818;;

constconst  intint kYSpacing  kYSpacing ==  3030;;
constconst  intint kXSpacing  kXSpacing ==  3030;;  
  
constconst  intint kTitleFontSize  kTitleFontSize ==  1010;;
constconst  intint kValueFontSize  kValueFontSize ==  88;;

constconst  doubledouble kValidatorMaxLimit  kValidatorMaxLimit ==  10001000;;
constconst  doubledouble kValidatorMinLimit  kValidatorMinLimit ==  --10001000;;
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The main drawCanvasDatadrawCanvasData(()) function for our example will look like this:

voidvoid  ProTutorialWidgetProTutorialWidget::::drawCanvasDatadrawCanvasData((DrawDataParamsDrawDataParams&& drawParams drawParams))
{{
Â Â Â Â Canvas& canvas = drawParams.canvas;Â Â Â Â Canvas& canvas = drawParams.canvas;
Â  Â  Rect& controlRect = drawParams.rect;Â  Â  Rect& controlRect = drawParams.rect;

Â  Â  int yScreenCoordinate = kYSpacing;Â  Â  int yScreenCoordinate = kYSpacing;
Â  Â  Rect titleRect(0, 0, controlRect.width, yScreenCoordinate);Â  Â  Rect titleRect(0, 0, controlRect.width, yScreenCoordinate);

Â  Â  drawGraphTitle(drawParams, titleRect, L"Widget example");Â  Â  drawGraphTitle(drawParams, titleRect, L"Widget example");
Â  Â  yScreenCoordinate += kYSpacing;Â  Â  yScreenCoordinate += kYSpacing;

Â  Â  size_t maxChannelsOnVisibleArea = (size_t)round(controlRect.height / kYSpacing);Â  Â  size_t maxChannelsOnVisibleArea = (size_t)round(controlRect.height / kYSpacing);

Â  Â  int channelIndex = 0;Â  Â  int channelIndex = 0;
Â  Â  ChannelList inputChannels = getInputChannels();Â  Â  ChannelList inputChannels = getInputChannels();
Â  Â  while ((channelIndex < inputChannels.getCount()) && (maxChannelsOnVisibleArea > 0))Â  Â  while ((channelIndex < inputChannels.getCount()) && (maxChannelsOnVisibleArea > 0))
Â  Â  {Â  Â  {
Â  Â  Â  Â  Channel channel = inputChannels[channelIndex];Â  Â  Â  Â  Channel channel = inputChannels[channelIndex];

Â  Â  Â  Â  drawChannelName(channel, drawParams, kXSpacing, yScreenCoordinate);Â  Â  Â  Â  drawChannelName(channel, drawParams, kXSpacing, yScreenCoordinate);
Â  Â  Â  Â  yScreenCoordinate += canvas.getTextHeight(channel.getName());Â  Â  Â  Â  yScreenCoordinate += canvas.getTextHeight(channel.getName());

Â  Â  Â  Â  drawChannelValue(channel, drawParams, controlRect.width, yScreenCoordinate, maxChannelsOnVisibleArea);Â  Â  Â  Â  drawChannelValue(channel, drawParams, controlRect.width, yScreenCoordinate, maxChannelsOnVisibleArea);
Â  Â  Â  Â  yScreenCoordinate += channel.getArraySize() * kYSpacing;Â  Â  Â  Â  yScreenCoordinate += channel.getArraySize() * kYSpacing;
Â  Â  Â  Â  channelIndex++;Â  Â  Â  Â  channelIndex++;
Â  Â  }Â  Â  }
}}

As we can see we will create two local variables one to remember the index of the last displayed channel and the other to keep
track of how much horizontal space on the widget we already used. We will also create a title rectangular for displaying the
global title of the widget and display it with the drawGraphTitledrawGraphTitle(()) function that we implemented ourselves. We will also
implement a function for drawing the current channel's name, value and unit. Our functions for drawing are defined in the
private section of the ProTutorialWidgetProTutorialWidget   class in the plugin.h file. We will also need a lot of additional helper functions, you
can see their definitions in the code below. 
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class ProTutorialWidget class ProTutorialWidget :: public Dewesoft public Dewesoft::::WidgetsWidgets::::ApiApi::::WidgetWidget
{{
publicpublic::
        // ...// ...

privateprivate::
        // ...// ...

Â Â Â Â double getChannelMinValue(Channel& ch);Â Â Â Â double getChannelMinValue(Channel& ch);
Â  Â  double getChannelMaxValue(Channel& ch);Â  Â  double getChannelMaxValue(Channel& ch);

Â  Â  int getCenterTextCoordinate(DrawDataParams& drawParams, Rect& rect, const std::wstring& text);Â  Â  int getCenterTextCoordinate(DrawDataParams& drawParams, Rect& rect, const std::wstring& text);
Â  Â  int getBarWidth(double currentValue, double minValue, double maxValue, Rect& barRect);Â  Â  int getBarWidth(double currentValue, double minValue, double maxValue, Rect& barRect);

Â  Â  void drawBar(Channel& channel, size_t arrayIndex, DrawDataParams& drawParams, Rect& barRect);Â  Â  void drawBar(Channel& channel, size_t arrayIndex, DrawDataParams& drawParams, Rect& barRect);
Â  Â  void drawGraphTitle(DrawDataParams& drawParams, Rect& titleRect, const std::wstring& text);Â  Â  void drawGraphTitle(DrawDataParams& drawParams, Rect& titleRect, const std::wstring& text);
Â  Â  void drawChannelName(Channel& channel, DrawDataParams& drawParams, int x, int y);Â  Â  void drawChannelName(Channel& channel, DrawDataParams& drawParams, int x, int y);
Â  Â  void drawChannelValue(Channel& channel, DrawDataParams& drawParams, int controlRectWidth, int y, size_t& maxChannelsOnVisibleArea);Â  Â  void drawChannelValue(Channel& channel, DrawDataParams& drawParams, int controlRectWidth, int y, size_t& maxChannelsOnVisibleArea);

Â  Â  std::wstring buildBarText(Channel& channel, size_t arrayIndex, double currentValue);Â  Â  std::wstring buildBarText(Channel& channel, size_t arrayIndex, double currentValue);
Â  Â  void drawUnit(Channel& channel, DrawDataParams& drawParams, Rect& barRect);Â  Â  void drawUnit(Channel& channel, DrawDataParams& drawParams, Rect& barRect);

Â  Â  std::wstring getChannelAxisValue(Channel& ch, int axisIndex, int index);Â  Â  std::wstring getChannelAxisValue(Channel& ch, int axisIndex, int index);
}}

What each of these functions does and how to use them will be explained later on in this section.
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voidvoid ProTutorialWidget ProTutorialWidget::::drawGraphTitledrawGraphTitle((DrawDataParamsDrawDataParams&& drawParams drawParams,, Rect Rect&& titleRect titleRect,,  constconst  
stdstd::::wstringwstring&& text text))  
{{
        Canvas& canvas = drawParams.canvas;Canvas& canvas = drawParams.canvas;
Â  Â  ColorPalette& colorPalette = drawParams.colorPalette;Â  Â  ColorPalette& colorPalette = drawParams.colorPalette;
Â  Â  CanvasTextFormats textFormat = { ctfCenter };Â  Â  CanvasTextFormats textFormat = { ctfCenter };

Â  Â  int textCenterXY = getCenterTextCoordinate(drawParams, titleRect, text);Â  Â  int textCenterXY = getCenterTextCoordinate(drawParams, titleRect, text);

Â  Â  CanvasFont& canvasFont = canvas.getFont();Â  Â  CanvasFont& canvasFont = canvas.getFont();
Â  Â  canvasFont.setSize(kTitleFontSize);Â  Â  canvasFont.setSize(kTitleFontSize);
Â Â Â Â canvasFont.setColor(colorPalette.fontColor);Â Â Â Â canvasFont.setColor(colorPalette.fontColor);
Â  Â  canvas.getBrush().setStyle(cbsClear);Â  Â  canvas.getBrush().setStyle(cbsClear);
Â  Â  canvas.textRect(titleRect.x, textCenterXY, titleRect.width, titleRect.height, text, textFormat);Â  Â  canvas.textRect(titleRect.x, textCenterXY, titleRect.width, titleRect.height, text, textFormat);  
}}

The drawGraphTitledrawGraphTitle(()) function accepts drawParams, title rectangle, and title text as parameters and it draws the text inside
a textRecttextRect(()). We want to output the text in the center on the top of the rectangle. The center of the rectangular is calculated
with the getCenterTextCoordinategetCenterTextCoordinate(()) function whose implementation looks like this.

intint ProTutorialWidget ProTutorialWidget::::getCenterTextCoordinategetCenterTextCoordinate((DrawDataParamsDrawDataParams&& drawParams drawParams,, Rect Rect&& rect rect,,  constconst  
stdstd::::wstringwstring&& text text))
{{
        returnreturn  intint((roundround((rectrect..y y ++  ((rectrect..height height -- rect rect..yy))  //  22  --  ((drawParamsdrawParams..canvascanvas..getTextHeightgetTextHeight((texttext))  //  22))))));;
}}
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voidvoid ProTutorialWidget ProTutorialWidget::::drawChannelNamedrawChannelName((ChannelChannel&& channel channel,, DrawDataParams DrawDataParams&& drawParams drawParams,,  intint x x,,  intint  
yy))
{{
Â Â Â Â Canvas& canvas = drawParams.canvas;Â Â Â Â Canvas& canvas = drawParams.canvas;
Â  Â  CanvasFont& canvasFont = canvas.getFont();Â  Â  CanvasFont& canvasFont = canvas.getFont();
Â  Â  canvasFont.setSize(userFontSize);Â  Â  canvasFont.setSize(userFontSize);
Â  Â  canvasFont.setColor(channel.getMainDisplayColor());Â  Â  canvasFont.setColor(channel.getMainDisplayColor());
Â  Â  canvas.getBrush().setStyle(cbsClear);Â  Â  canvas.getBrush().setStyle(cbsClear);
Â  Â  canvas.textOut(x, y, channel.getName());Â  Â  canvas.textOut(x, y, channel.getName());
}}

The drawChannelNamedrawChannelName(()) is a very simple function that sets the font size and color of the text we want to display and then
displays the name of the current channel. The position of the text is calculated beforehand in the drawCanvasDatadrawCanvasData(())
function.
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voidvoid ProTutorialWidget ProTutorialWidget::::drawChannelValuedrawChannelValue((ChannelChannel&& channel channel,, DrawDataParams DrawDataParams&& drawParams drawParams,,  intint  
controlRectWidthcontrolRectWidth,,  intint y y,, size_t size_t&& maxChannelsOnVisibleArea maxChannelsOnVisibleArea))
{{
        Rect barRect(kXSpacing, y, controlRectWidth - 4 * kYSpacing, kBarHeight);Rect barRect(kXSpacing, y, controlRectWidth - 4 * kYSpacing, kBarHeight);

Â  Â  drawUnit(channel, drawParams, barRect);Â  Â  drawUnit(channel, drawParams, barRect);

Â  Â  size_t arrayIndex = 0;Â  Â  size_t arrayIndex = 0;
Â  Â  while ((arrayIndex < static_cast<size_t>(channel.getArraySize())) && (maxChannelsOnVisibleArea > 0))Â  Â  while ((arrayIndex < static_cast<size_t>(channel.getArraySize())) && (maxChannelsOnVisibleArea > 0))
Â  Â  {Â  Â  {
Â  Â  Â  Â  drawBar(channel, arrayIndex, drawParams, barRect);Â  Â  Â  Â  drawBar(channel, arrayIndex, drawParams, barRect);
Â  Â  Â  Â  maxChannelsOnVisibleArea--;Â  Â  Â  Â  maxChannelsOnVisibleArea--;
Â  Â  Â  Â  arrayIndex++;Â  Â  Â  Â  arrayIndex++;
Â  Â  }Â  Â  }
}}

Now we just need to draw the channel value inside a bar. The bar will be represented as a rectangular and inside of it we first
draw the value of the channel and then fill the rectangular to match the channel value. We will create an additional function
drawBardrawBar(()) for drawing the actual bar. We also add additional helper functions getBarWidthgetBarWidth(()) for calculating how much of
the bar we have to fill, buildBarTextbuildBarText(()) for reading the correct text from the channel and getChannelAxisValuegetChannelAxisValue(()) if the input
channel is vector or matrix to read the values from the axis. The drawChannelValuedrawChannelValue(()) function gets called for every channel
that will be displayed on our widget. If the channel is of vector or matrix type then we will display every axis value as its own
bar with name and unit. We also need to keep track of how many channels we been already drawn on widget because we do
not want to draw a channel on an area of the widget that can not be seen by the user.
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voidvoid ProTutorialWidget ProTutorialWidget::::drawUnitdrawUnit((ChannelChannel&& channel channel,, DrawDataParams DrawDataParams&& drawParams drawParams,, Rect Rect&& barRect barRect))  
{{  
Â Â Â Â Canvas& canvas = drawParams.canvas;Â Â Â Â Canvas& canvas = drawParams.canvas;
Â  Â  CanvasFont canvasFont = canvas.getFont();Â  Â  CanvasFont canvasFont = canvas.getFont();
Â  Â  ColorPalette& colorPalette = drawParams.colorPalette;Â  Â  ColorPalette& colorPalette = drawParams.colorPalette;

Â  Â  canvasFont.setSize(kValueFontSize);Â  Â  canvasFont.setSize(kValueFontSize);
Â  Â  canvasFont.setColor(colorPalette.fontColor);Â  Â  canvasFont.setColor(colorPalette.fontColor);
Â  Â  canvas.getBrush().setStyle(cbsClear);Â  Â  canvas.getBrush().setStyle(cbsClear);
Â  Â  canvas.textOut(barRect.x + barRect.width + 10, barRect.y, channel.getUnit());Â  Â  canvas.textOut(barRect.x + barRect.width + 10, barRect.y, channel.getUnit());
}}

The drawUnitdrawUnit(()) is again a very simple function that sets the font size and color and displays the unit of the channel at the end
of the bar.
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voidvoid ProTutorialWidget ProTutorialWidget::::drawBardrawBar((ChannelChannel&& channel channel,, size_t arrayIndex size_t arrayIndex,, DrawDataParams DrawDataParams&& drawParams drawParams,,  
RectRect&& barRect barRect))
{{
        Canvas& canvas = drawParams.canvas;Canvas& canvas = drawParams.canvas;
Â  Â  CanvasFont canvasFont = canvas.getFont();Â  Â  CanvasFont canvasFont = canvas.getFont();
Â  Â  CanvasBrush canvasBrush = canvas.getBrush();Â  Â  CanvasBrush canvasBrush = canvas.getBrush();
Â  Â  CanvasPen canvasPen = canvas.getPen();Â  Â  CanvasPen canvasPen = canvas.getPen();
Â  Â  ColorPalette& colorPalette = drawParams.colorPalette;Â  Â  ColorPalette& colorPalette = drawParams.colorPalette;

Â  Â  double maxValue = getChannelMaxValue(channel);Â  Â  double maxValue = getChannelMaxValue(channel);
Â  Â  double minValue = getChannelMinValue(channel);Â  Â  double minValue = getChannelMinValue(channel);

Â  Â  double currentValue = channel.getCurrentValue(static_cast<int>(arrayIndex));Â  Â  double currentValue = channel.getCurrentValue(static_cast<int>(arrayIndex));

Â  Â  canvasBrush.setColor(colorPalette.backColor);Â  Â  canvasBrush.setColor(colorPalette.backColor);
Â  Â  canvasPen.setColor(colorPalette.fontColor);Â  Â  canvasPen.setColor(colorPalette.fontColor);
Â  Â  canvas.rectangle(barRect.x, barRect.y, barRect.x + barRect.width, barRect.y + barRect.height);Â  Â  canvas.rectangle(barRect.x, barRect.y, barRect.x + barRect.width, barRect.y + barRect.height);

Â  Â  canvasBrush.setColor(channel.getMainDisplayColor());Â  Â  canvasBrush.setColor(channel.getMainDisplayColor());
Â  Â  canvasPen.setColor(colorPalette.fontColor);Â  Â  canvasPen.setColor(colorPalette.fontColor);
Â  Â  canvas.fillRect(barRect.x + 1, barRect.y + 1, getBarWidth(currentValue, minValue, maxValue, barRect), barRect.y + barRect.height);Â  Â  canvas.fillRect(barRect.x + 1, barRect.y + 1, getBarWidth(currentValue, minValue, maxValue, barRect), barRect.y + barRect.height);

Â  Â  canvasFont.setSize(kValueFontSize);Â  Â  canvasFont.setSize(kValueFontSize);
Â  Â  canvasFont.setColor(dcom::Color::White);Â  Â  canvasFont.setColor(dcom::Color::White);
Â  Â  canvasBrush.setStyle(cbsClear);Â  Â  canvasBrush.setStyle(cbsClear);
Â  Â  canvas.textOut(barRect.x + 2, barRect.y + 2, buildBarText(channel, arrayIndex, currentValue));Â  Â  canvas.textOut(barRect.x + 2, barRect.y + 2, buildBarText(channel, arrayIndex, currentValue));

Â  Â  barRect.y += kYSpacing;Â  Â  barRect.y += kYSpacing;
}}

The drawBardrawBar(()) function draws the value of the channel and fills the bar in the ratio to the value and the minimal and maximal
value of the channel. To draw a the container of the bar we use the rectanglerectangle(()) function with the specified rectangle
dimensions. To fill the bar (rectangle) we use the fillRectfillRect(()) function and with the helper function getBarWidthgetBarWidth(()) we calculate
the point to which the bar needs to be filled. We will also write a getter function for reading the minimum and maximum values
of the channel whether they are user-defined or default.
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doubledouble ProTutorialWidget ProTutorialWidget::::getChannelMinValue(Channel& ch)getChannelMinValue(Channel& ch)
{{
Â  Â  if (useManualLimits)Â  Â  if (useManualLimits)
Â  Â  Â  Â  return minChannelValue;Â  Â  Â  Â  return minChannelValue;
Â  Â  elseÂ  Â  else
Â  Â  Â  Â  return ch.getTypicalMinValue();Â  Â  Â  Â  return ch.getTypicalMinValue();
}}

doubledouble ProTutorialWidget ProTutorialWidget::::getChannelMaxValue(Channel& ch)getChannelMaxValue(Channel& ch)
{{
Â  Â  if (useManualLimits)Â  Â  if (useManualLimits)
Â  Â  Â  Â  return maxChannelValue;Â  Â  Â  Â  return maxChannelValue;
Â  Â  elseÂ  Â  else
Â  Â  Â  Â  return ch.getTypicalMaxValue();Â  Â  Â  Â  return ch.getTypicalMaxValue();
}}

intint ProTutorialWidget ProTutorialWidget::::getBarWidthgetBarWidth((doubledouble currentValue currentValue,,  doubledouble minValue minValue,,  doubledouble maxValue maxValue,, Rect Rect&&  
barRectbarRect))  
{{  
        currentValue = std::clamp(currentValue, minValue, maxValue);currentValue = std::clamp(currentValue, minValue, maxValue);
Â  Â  int currentValueInPixels = (maxValue - minValue == 0.0) ? 0 : static_cast<int>(round((currentValue - minValue) / (maxValue - minValue) * barRect.width));Â  Â  int currentValueInPixels = (maxValue - minValue == 0.0) ? 0 : static_cast<int>(round((currentValue - minValue) / (maxValue - minValue) * barRect.width));
Â  Â  return barRect.x + currentValueInPixels - 1;Â  Â  return barRect.x + currentValueInPixels - 1;
}}  

stdstd::::wstring ProTutorialWidgetwstring ProTutorialWidget::::buildBarTextbuildBarText((ChannelChannel&& channel channel,, size_t arrayIndex size_t arrayIndex,,  doubledouble currentValue currentValue))  
{{  
        ifif  ((channelchannel..getArrayChannelgetArrayChannel(())))  
                returnreturn  getChannelAxisValuegetChannelAxisValue((channelchannel,,  00,, arrayIndex arrayIndex))  ++ L L": "": "  ++ std std::::to_wstringto_wstring((currentValuecurrentValue));;
        elseelse
                returnreturn std std::::to_wstringto_wstring((currentValuecurrentValue));;  
}}

Because array channels have axis values we also need to add a function for reading the values. Array channels can have
multiple axes so we need to specify the index of which axis information we would like to access in the getAxisDefinitiongetAxisDefinition(())
function. The axis values can be of three types: string, float or a linear function but we don't need to worry about that because
the  getAxisValuegetAxisValue(()) function will handle all that for us and return the correct axis value based on its type.

stdstd::::wstring ProTutorialWidgetwstring ProTutorialWidget::::getChannelAxisValuegetChannelAxisValue((ChannelChannel&& ch ch,,  intint axisIndex axisIndex,,  intint index index))
{{
 Â  Â  Â  Â AxisDefiniton axisDef = ch.getArrayInfo().getAxisDefinition(axisIndex);AxisDefiniton axisDef = ch.getArrayInfo().getAxisDefinition(axisIndex);
Â  Â  return axisDef.getAxisValue(index);Â  Â  return axisDef.getAxisValue(index);
}}
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Our widget will now show the data like this:

The image shows two input channels both of them are the output channels of the FFT Analyser with one begin scalar channel
(FFT block count) and the other one being a vector channel (AI 1/AmplFFT).
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Example II: Visual Properties
The last thing we need to do now is add the visual properties for manipulating our widget. We will add a drop-down menu for
choosing the font size, a checkbox for choosing whether or not to use manual minimum and maximum limits, two text boxes
for inputting the limits, and a reset button for resetting the changed properties back to default. In the end, our left panel should
look like this:

As before we will first define these visual properties as enums of the type VisualPropertiesVisualProperties  in the plugin.h file 

struct VisualPropertiesstruct VisualProperties
{{
Â  Â  static constexpr char MinEditText[] = "MinEditText";Â  Â  static constexpr char MinEditText[] = "MinEditText";
Â  Â  static constexpr char MaxEditText[] = "MaxEditText";Â  Â  static constexpr char MaxEditText[] = "MaxEditText";
Â  Â  static constexpr char FontSizeSelect[] = "FontSizeSelect";Â  Â  static constexpr char FontSizeSelect[] = "FontSizeSelect";
Â  Â  static constexpr char ResetLabel[] = "ResetLabel";Â  Â  static constexpr char ResetLabel[] = "ResetLabel";
Â  Â  static constexpr char ManualLimitsCheckbox[] = "ManualLimitsCheckbox";Â  Â  static constexpr char ManualLimitsCheckbox[] = "ManualLimitsCheckbox";
};};

initVisualProperties
We will initiate the visual properties the same way we did in the first example. The drop-down menu, the reset button, and the
text box are all properties we used before. We need to add a checkbox with addCheckBoxPropertyaddCheckBoxProperty(()).
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voidvoid ProTutorialWidget ProTutorialWidget::::initVisualPropertiesinitVisualProperties((VCPropertiesVCProperties&& visualProperties visualProperties))
{{
Â  Â  group = visualProperties.addOrFindGroup("Advanced");Â  Â  group = visualProperties.addOrFindGroup("Advanced");
Â  Â  group.setName(L"Drawing Options");Â  Â  group.setName(L"Drawing Options");
Â  Â  SelectVCProperty fontSizeDropDown(group.addSelectProperty(VisualProperties::FontSizeSelect, L"Font size"));Â  Â  SelectVCProperty fontSizeDropDown(group.addSelectProperty(VisualProperties::FontSizeSelect, L"Font size"));
Â  Â  fontSizeDropDown.add(L"12");Â  Â  fontSizeDropDown.add(L"12");
Â  Â  fontSizeDropDown.add(L"14");Â  Â  fontSizeDropDown.add(L"14");
Â  Â  fontSizeDropDown.add(L"16");Â  Â  fontSizeDropDown.add(L"16");
Â  Â  fontSizeDropDown.add(L"18");Â  Â  fontSizeDropDown.add(L"18");

Â  Â  group.addCheckBoxProperty(VisualProperties::ManualLimitsCheckbox, L"Use manual limits");Â  Â  group.addCheckBoxProperty(VisualProperties::ManualLimitsCheckbox, L"Use manual limits");
Â  Â  group.addFloatProperty(VisualProperties::MaxEditText, L"Max channel value");Â  Â  group.addFloatProperty(VisualProperties::MaxEditText, L"Max channel value");
Â  Â  group.addFloatProperty(VisualProperties::MinEditText, L"Min channel value");Â  Â  group.addFloatProperty(VisualProperties::MinEditText, L"Min channel value");
Â  Â  LabelVCProperty labelButton(group.addLabelProperty(VisualProperties::ResetLabel, L"Reset to default"));Â  Â  LabelVCProperty labelButton(group.addLabelProperty(VisualProperties::ResetLabel, L"Reset to default"));
Â  Â  labelButton.addButton(L"Reset properties to default", "REFRESH");Â  Â  labelButton.addButton(L"Reset properties to default", "REFRESH");
}}
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Before we look at the other functions we still need to implement, we will add functions for updating the validators for minimum
and maximum channel values. We need to make sure that the minimum channel value is always lower than the maximum
channel value. We will also enable or disable the text boxes based on the users choice to use the manual limits or not.

Our functions for setting the validator are defined in the private section of the ProTutorialWidgetProTutorialWidget  class in the plugin.h file.

class ProTutorialWidget class ProTutorialWidget :: public Dewesoft public Dewesoft::::WidgetsWidgets::::ApiApi::::Widget Widget {{ public public::        
        // ...// ...
 private private::        
        // ... // ... 
        voidvoid  updateMinEditValidatorupdateMinEditValidator(());;  
        voidvoid  updateMaxEditValidatorupdateMaxEditValidator(());;    
}}

The implementation of the functions in the plugin.cpp file looks like this:

voidvoid ProTutorialWidget ProTutorialWidget::::updateMinEditValidatorupdateMinEditValidator(())
{{
Â  Â Â Â  Â Â FloatVCProperty minEditText(group.findProperty(VisualProperties::MinEditText));FloatVCProperty minEditText(group.findProperty(VisualProperties::MinEditText));
Â  Â  if (minEditText.isAssigned())Â  Â  if (minEditText.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  minEditText.setMinValue(kValidatorMinLimit);Â  Â  Â  Â  minEditText.setMinValue(kValidatorMinLimit);
Â  Â  Â  Â  minEditText.setMaxValue(maxChannelValue);Â  Â  Â  Â  minEditText.setMaxValue(maxChannelValue);
Â  Â  Â  Â  minEditText.setEnabled(useManualLimits);Â  Â  Â  Â  minEditText.setEnabled(useManualLimits);
Â  Â  }Â  Â  }
}}

voidvoid ProTutorialWidget ProTutorialWidget::::updateMaxEditValidatorupdateMaxEditValidator(())
{{
Â  Â Â Â  Â Â FloatVCProperty maxEditText(group.findProperty(VisualProperties::MaxEditText));FloatVCProperty maxEditText(group.findProperty(VisualProperties::MaxEditText));
Â  Â  if (maxEditText.isAssigned())Â  Â  if (maxEditText.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  maxEditText.setMinValue(minChannelValue);Â  Â  Â  Â  maxEditText.setMinValue(minChannelValue);
Â  Â  Â  Â  maxEditText.setMaxValue(kValidatorMaxLimit);Â  Â  Â  Â  maxEditText.setMaxValue(kValidatorMaxLimit);
Â  Â  Â  Â  maxEditText.setEnabled(useManualLimits);Â  Â  Â  Â  maxEditText.setEnabled(useManualLimits);
Â  Â  }Â  Â  }
}}

updateVisualProperties
We update all the visual properties to the value of the corresponding variables.
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voidvoid ProTutorialWidget ProTutorialWidget::::updateVisualPropertiesupdateVisualProperties((VCPropertiesVCProperties&& visualProperties visualProperties))
{{
        group = visualProperties.findGroup("Advanced");group = visualProperties.findGroup("Advanced");

Â  Â  CheckBoxVCProperty manualLimitsCheckbox(group.findProperty(VisualProperties::ManualLimitsCheckbox));Â  Â  CheckBoxVCProperty manualLimitsCheckbox(group.findProperty(VisualProperties::ManualLimitsCheckbox));
Â  Â  if (manualLimitsCheckbox.isAssigned())Â  Â  if (manualLimitsCheckbox.isAssigned())
Â  Â  Â  Â  manualLimitsCheckbox.setChecked(useManualLimits);Â  Â  Â  Â  manualLimitsCheckbox.setChecked(useManualLimits);

Â  Â  FloatVCProperty minEditText(group.findProperty(VisualProperties::MinEditText));Â  Â  FloatVCProperty minEditText(group.findProperty(VisualProperties::MinEditText));
Â  Â  if (minEditText.isAssigned())Â  Â  if (minEditText.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  minEditText.setValue(minChannelValue);Â  Â  Â  Â  minEditText.setValue(minChannelValue);
Â  Â  Â  Â  updateMaxEditValidator();Â  Â  Â  Â  updateMaxEditValidator();
Â  Â  }Â  Â  }

Â  Â  FloatVCProperty maxEditText(group.findProperty(VisualProperties::MaxEditText));Â  Â  FloatVCProperty maxEditText(group.findProperty(VisualProperties::MaxEditText));
Â  Â  if (maxEditText.isAssigned())Â  Â  if (maxEditText.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  maxEditText.setValue(maxChannelValue);Â  Â  Â  Â  maxEditText.setValue(maxChannelValue);
Â  Â  Â  Â  updateMinEditValidator();Â  Â  Â  Â  updateMinEditValidator();
Â  Â  }Â  Â  }

Â  Â  SelectVCProperty fontSizeDropDown(group.findProperty(VisualProperties::FontSizeSelect));Â  Â  SelectVCProperty fontSizeDropDown(group.findProperty(VisualProperties::FontSizeSelect));
Â  Â  if (fontSizeDropDown.isAssigned())Â  Â  if (fontSizeDropDown.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  std::wstring fontSizeText = std::to_wstring(userFontSize);Â  Â  Â  Â  std::wstring fontSizeText = std::to_wstring(userFontSize);
Â  Â  Â  Â  fontSizeDropDown.setItemIndex(0);Â  Â  Â  Â  fontSizeDropDown.setItemIndex(0);
Â  Â  Â  Â  for (int i = 0; i < fontSizeDropDown.getCount(); i++)Â  Â  Â  Â  for (int i = 0; i < fontSizeDropDown.getCount(); i++)
Â  Â  Â  Â  {Â  Â  Â  Â  {
Â  Â  Â  Â  Â  Â  if (fontSizeDropDown.getItem(i) == fontSizeText)Â  Â  Â  Â  Â  Â  if (fontSizeDropDown.getItem(i) == fontSizeText)
Â  Â  Â  Â  Â  Â  {Â  Â  Â  Â  Â  Â  {
Â  Â  Â  Â  Â  Â  Â  Â  fontSizeDropDown.setItemIndex(i);Â  Â  Â  Â  Â  Â  Â  Â  fontSizeDropDown.setItemIndex(i);
 Â  Â  Â  Â  Â  Â  Â  userFontSize = std::stoi(fontSizeDropDown.getItem(i)); Â  Â  Â  Â  Â  Â  Â  userFontSize = std::stoi(fontSizeDropDown.getItem(i));
Â  Â  Â  Â  Â  Â  }Â  Â  Â  Â  Â  Â  }
Â  Â  Â  Â  }Â  Â  Â  Â  }
Â  Â  }Â  Â  }
}}

visualPropertyChanged
When one of the visual properties changes we save the new value of the property to a corresponding variable.
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voidvoid ProTutorialWidget ProTutorialWidget::::visualPropertyChangedvisualPropertyChanged((stdstd::::stringstring&& groupId groupId,, VCProperty VCProperty&& visualProperty visualProperty))
{{
Â  Â Â Â  Â Â std::string propID = visualProperty.getId();std::string propID = visualProperty.getId();

Â  Â  if (propID == VisualProperties::ManualLimitsCheckbox)Â  Â  if (propID == VisualProperties::ManualLimitsCheckbox)
Â  Â  {Â  Â  {
Â  Â  Â  Â  CheckBoxVCProperty manualLimitsCheckbox(visualProperty);Â  Â  Â  Â  CheckBoxVCProperty manualLimitsCheckbox(visualProperty);
Â  Â  Â  Â  useManualLimits = manualLimitsCheckbox.getChecked();Â  Â  Â  Â  useManualLimits = manualLimitsCheckbox.getChecked();
Â  Â  }Â  Â  }
Â  Â  else if (propID == VisualProperties::MinEditText)Â  Â  else if (propID == VisualProperties::MinEditText)
Â  Â  {Â  Â  {
Â  Â  Â  Â  FloatVCProperty minText(visualProperty);Â  Â  Â  Â  FloatVCProperty minText(visualProperty);
Â  Â  Â  Â  minChannelValue = minText.getValue();Â  Â  Â  Â  minChannelValue = minText.getValue();
Â  Â  }Â  Â  }
Â  Â  else if (propID == VisualProperties::MaxEditText)Â  Â  else if (propID == VisualProperties::MaxEditText)
Â  Â  {Â  Â  {
Â  Â  Â  Â  FloatVCProperty maxText(visualProperty);Â  Â  Â  Â  FloatVCProperty maxText(visualProperty);
Â  Â  Â  Â  maxChannelValue = maxText.getValue();Â  Â  Â  Â  maxChannelValue = maxText.getValue();
Â  Â  }Â  Â  }
Â  Â  else if (propID == VisualProperties::FontSizeSelect)Â  Â  else if (propID == VisualProperties::FontSizeSelect)
Â  Â  {Â  Â  {
Â  Â  Â  Â  SelectVCProperty select(visualProperty);Â  Â  Â  Â  SelectVCProperty select(visualProperty);
Â  Â  Â  Â  userFontSize = std::stoi(select.getItem(select.getItemIndex()));Â  Â  Â  Â  userFontSize = std::stoi(select.getItem(select.getItemIndex()));
Â  Â  }Â  Â  }
}}

visualPropertyButtonClick
When the user clicks the reset button we will call a function resetPropertiesToDefaultresetPropertiesToDefault(()) to set the visual properties back to
default.

voidvoid ProTutorialWidget ProTutorialWidget::::visualPropertyButtonClickvisualPropertyButtonClick((stdstd::::stringstring&& groupId groupId,, VCProperty VCProperty&& visualProperty visualProperty,,  intint  
buttonIndexbuttonIndex))
{{
Â  Â  if (visualProperty.getId() == VisualProperties::ResetLabel)Â  Â  if (visualProperty.getId() == VisualProperties::ResetLabel)
Â  Â  Â  Â  resetPropertiesToDefault();Â  Â  Â  Â  resetPropertiesToDefault();
}}

The function should first be defined in the private section of the ProTutorialWidgetProTutorialWidget  class in the plugin.h file. 
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class ProTutorialWidgetclass ProTutorialWidget:: public Dewesoft public Dewesoft::::WidgetsWidgets::::ApiApi::::WidgetWidget
{{
publicpublic::
        // ...// ...

privateprivate
        // ...// ...
        voidvoid  resetPropertiesToDefaultresetPropertiesToDefault(());;
}}

The implementation of the function in the plugin.cpp file looks like this:

voidvoid ProTutorialWidget ProTutorialWidget::::resetPropertiesToDefaultresetPropertiesToDefault(())
{{
        FloatVCProperty minEditText(group.findProperty(VisualProperties::MinEditText));FloatVCProperty minEditText(group.findProperty(VisualProperties::MinEditText));
Â  Â  if (minEditText.isAssigned())Â  Â  if (minEditText.isAssigned())
Â Â Â Â {Â Â Â Â {
Â  Â  Â  Â  minEditText.setValue(0);Â  Â  Â  Â  minEditText.setValue(0);
Â  Â  Â  Â  minChannelValue = 0.0;Â  Â  Â  Â  minChannelValue = 0.0;
Â  Â  }Â  Â  }

Â  Â  FloatVCProperty maxEditText(group.findProperty(VisualProperties::MaxEditText));Â  Â  FloatVCProperty maxEditText(group.findProperty(VisualProperties::MaxEditText));
Â  Â  if (maxEditText.isAssigned())Â  Â  if (maxEditText.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  maxEditText.setValue(0);Â  Â  Â  Â  maxEditText.setValue(0);
Â  Â  Â  Â  maxChannelValue = 0.0;Â  Â  Â  Â  maxChannelValue = 0.0;
Â  Â  }Â  Â  }

Â  Â  SelectVCProperty fontSizeDropDown(group.findProperty(VisualProperties::FontSizeSelect));Â  Â  SelectVCProperty fontSizeDropDown(group.findProperty(VisualProperties::FontSizeSelect));
Â  Â  if (fontSizeDropDown.isAssigned())Â  Â  if (fontSizeDropDown.isAssigned())
Â  Â  {Â  Â  {
Â  Â  Â  Â  fontSizeDropDown.setItemIndex(0);Â  Â  Â  Â  fontSizeDropDown.setItemIndex(0);
Â  Â  Â  Â  userFontSize = 12;Â  Â  Â  Â  userFontSize = 12;
Â  Â  }Â  Â  }
}}
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Example II: Result
After all the steps in the previous sections, we should get a widget that looks like this. It accepts input channels of any type
(scalar, vector or matrix) and displays the current value of the channel or the axis and the channel name and unit. It also
displays the title of the graph. User can change the font type and set manual minimum and maximum limits of the channel. We
also added a reset button to reset the changed values back to default. 

The channels displayed on the image above are the time signal and the output channels from the FFT Analysis when the
acquisition sample rate is set to 100 and the resolution of the FFT is set to 5 lines.
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Import/export
In this Pro Training, we have created two new widgets. We might want to use them in other setups or on other computers. C++
Widget Plugin packs your plugin into an external library, which can be inserted into any Dewesoft around the world.

Your C++ Widget Plugin is found inside a file with .vc extension (it contains instructions that Dewesoft can call upon to do
certain things, based on the purpose of your plugin). To export it, you need to locate these files first. It can be found inside
DEWESoftX\DEWEsoft\Bin\Addons folder in a folder with the same name as the plugin base class name.

To import your plugin you have to copy and paste a file with .vc extension into any Dewesoft that requires your plugin. You
need to paste it inside Addons folder so Dewesoft will be able to automatically recognize and load it.

Your C++ Widget Plugin also creates a file with the .pdb extension, which contains instructions for your debugger. It is not
necessary to export it with your .vc file in order for your plugin to work, but in case the imported plugin will be debugged,
copying the entire folder is a good idea.
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